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ACADAMIC CELL, NPS GDC Women(A) 
Chittoor  

Proceedings of the Principal, NPS Govt. Degree College for Women(A), Chittoor 

Present: Dr. K. Manohar 

 
Rc.No. MGT/BBA/ 01 /NPSGDCW/UG-BoS/2025-26 dt. 28-09-2025 

 

         Subject:  NPS GDC Women(A), Chittoor – UG Board of Studies (BoS) –   Nomination of Members –    

                          Orders issued.  

         Ref.: 1. UGC Guidelines of for Autonomous Colleges – 2023. 

                  2. Proc. of the VC No: SVU/C-III (3)/BoS/Smt. N.P.S. Govt. Coll/chi/2025 

*** 

Order 
 

The Principal, NPS GDC Women(A) pleased to inform that to conduct Board of Studies Members meeting in the subject of 

commerce B.Com CA, Gen, BBA & BFSI for the academic years 2025-26 to  2027-28 to the concerned course or till the date of your 

retirement / transfer whichever is earlier. Following the norms of the UGC Regulations, 2023. 

 A copy of the list of members of the Board of Studies of Commerce is herewith enclosed for your information. Your 

acceptance is a pleasure to serve in the board and the college expects your valuable advice / suggestions during the above period. 

S.NO Name & Designation Chairperson/ Member Signature 

1 Dr. T.Vinila Chairperson  

2 Prof.P.Mohan  Reddy University Nominee   

3 Prof.Raghunadha Reddy University Nominee  

4 Dr.K.Nandeeswaraiah Subject experts by University  

5 Dr.V.Maslamani Subject expert   

6 Dr.k.Sankar Reddy Subject expert   

7 Sri.A.M.Narendra kumar Industrialist  

8 Dr.J.Ramadevi Member  

9 2.N.Kasturamma Member  

10 G.Yamuna Alumni  

 

The above members are requested to attend the BoS meeting for the first autonomous UG-Batch 2025-26 and 

share their valuable, Suggestion on the following functionaries. 

 

a) Prepare the syllabi for the subject keeping in view the objectives of the College, interest of the stakeholders and national 

recruitment for consideration and approval of the IQAC and Academic Cell. 

b) Suggest methodologies for innovative teaching and evaluation techniques. 

c) Suggest the panel of names to the Academic Council for appointment of Examiners 

d) Coordinate research, teaching, extension and other activities in the department and the college. 

e) Suggest CLO,PLO, and subject experts to develop question bank in compliance with bloom’s 

Taxamony 

f) The above said members are requested to bestow their services for the successful organization of the events whenever 

scheduled. 

 

                                                                                                                                         Principal 
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Department of Commerce & Management 
BOARD OF STUDIES MEMBERS ACADEMIC YEAR 2025-2026 t0 2027-28 

 
            

 
                       

 

 

 

 

 

 

 

 

 

 

 
            

 
                       

 

 

 

 

 

 

 

 

 

 

S.NO                  

Category 

Name & Designation Chairperson/ Member 

1 Chairperson Dr. T.VINILA 

Lecturer in Commerce 

Smt.N.P.S GDC For 

women(A) Chitoor. 

Faculty 

Mobile: 8897799816 

thadipallivinila@gmail.com 

2 Members of the 

Department 

 

1.Dr.J.Ramadevi 

Lecturer in Commerce 

2.N.Kasturamma 

Lecturer in Commerce 

 

Members 

Mobile: 9177639191 

Email: jaanujeswi@gmail.com 

Mobile:9492067954 

Email: kasturamma05@gmail.com 

3 One expert from 

to be nominated by 

the Vice-

Chancellor 

Prof.P.Mohan  Reddy 

Dept.of Commerce 

SVU College of CM & 

CS 

Tirupathi 

University Nominee 
Mobile:9849063909 

Email:dr.pmohanreddy@gmail.com 

4 One  Experts in the 

Subject nominated 

by 

Vice-Chancellor   

Prof.Raghunadha 

Reddy 

Dept.of Management 

SVU College of CM & 

CS 

Tirupathi 

University Nominee 

Mobile:9346234167 

Email:dr.reddy@gmail.com 

5 One  Experts in the 

Subject from 

outside the college 

to be nominated by 

University 

Dr.K.Nandeeswaraiah 

Lecturer in Commerce 

SVCR Govt. Degree 

College 

Palamaner 

Subject experts by University 

Mobile:9440396477 

Emai:knadeeswae@gmail.com 

6 Two Experts in the 

Subject from 

outside the college 

to be nominated by 

Academic council 

1.Dr.V.Maslamani 

Lecturer in Commerce 

GDC Pakala 

Tirupathi dt. 

2.Dr.k.Sankar Reddy 

Lecturer in commerce 

GDC,Vedurukuppam. 

Mobile:9290198731 

Email id:vm4606@gmail.com 

 

 

Mobile: 9866415051 

Email id :sankar.nali@gmail.com 

 

 

 

 

 

 

mailto:jaanujeswi@gmail.com
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            Signature of the chairperson         Signature of the BOS Members 
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Representative 

from the Industry/ 

Corporate Sector 

A.M.Narendra kumar 

District Tourism Officer 

Chittoor 

Mobile: 9441392480 

Email: 

amnarendrakumar@gmail.com 

8 One Meritorious 

Alumnus 

G.Yamuna 

Guest faculty  in 

Commerce 

Smt.N.P.S GDC For 

women(A) Chittoor 

 

Mobile: 9502377593 

Email 

id:yamunabujji1984@gmail.com 
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Department of Management 

ACADEMIC YEAR  2025-2026 

                                                               UG BBA HONOURS  

                                                      
BOARD OF STUDIES MEMBERS 

MINUTES OF THE MEETING 

 

 

The 1st meeting of BOS in Commerce to be held on 30-10 -2025 at 11.00AM 

 

      Agenda: 

1. To discuss 

2. Approval for UG Course structure of Commerce 

3. Approval for changes in the UG B.BA Honours I Semester paper entitled Business Organisation and 

Management  and Principles of Management and II Semester Managerial Economics and Business Law 

syllabus, model question paper and blue print. 

4. Panel of question paper setters and examiners. 

5. Pedagogy of Teaching – learning as per UGC guidelines 

6. Additional Inputs to the Curriculum 

7. Internal assessment component and additional credits for extra - curricular activities. 

8. Evaluation and assessment pattern. 

9. Introduction of new certificate and diploma courses 

10. Other academic and extra-curricular activities of the department 

11. Any other proposal with permission of the chair. 

 

     Signature of the Chairman               Signature of the BOS Members                                                                                                                                                     
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Department of Commerce  

ACADEMIC YEAR  2025-2026 

                                                                     UG BBA HONOURS 

Resolution of the BoS Meeting for I &II Semesters 

 
In the present BOS meeting the following resolutions were made and unanimously approved by the committee. 

The decisions / changes wherever necessary, taken at college level may be adopted in the consecutive academic 

years on the date of BOS meeting conducted 27-10-2025, 11:30 am. 

 Resolutions of the Meeting :  

   It is resolved unanimously 

 
1. The college was conferred with autonomy by the UGC in the month 04-09-2024. Subsequently, the 

college submitted letters to the parent university(SVU), UGC and to the Govt. of AP for constitution of 

Statutory Bodies and release of notification by the affiliating university. The Registrar, S.V. University issued 

notification and directed to implement autonomy from the academic year 2025-26. The college prepared its own 

academic schedule after the conferment of autonomy. Accordingly, the college has been implementing 

autonomy for I year degree I & II semester students from the date of issuance of notification on adhoc basis 

following the academic regulations of the parent university and covered the prescribed syllabus in the first 

semester by making certain changes. The syllabus, course structure, model question papers and blue print are 

placed before the committee for ratification. 

2. As per the academic schedule for I semester of I year students was started on 22-09-2025 and the academic 

instruction has been given to the students as per the syllabus designed by the internal BOS members. It is 

placed before the committee for constructive suggestions for further improvement keeping in view the local 

needs / market demand / industry-needs / employment generation as per the UGC Regulations 2023. 

 

3. Resolved to ratify the panel of question paper setters nominated for UG I year semester I Examinations. 

4. Resolved to follow the pedagogy of teaching / learning strategies as per the UGC guidelines. 
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5. Resolved to use additional inputs to enrich the curriculum and enlighten the students on academic 

performance. 

6. To include internal assessment components and additional credits for extracurricular activities of the 

students. 

7. To follow the evaluation and assessment pattern strictly adhering the UGC norms and guidelines. 

8. To introduce new certificate and diploma courses related to subject and other courses deemed to be 

useful for the students. 

9. To take the valuable suggestions of the BOS on academic and extra-curricular activities to be taken up at 

department level for strengthening the academic instruction to the students. 

10. If any discussion related to academic matters including extracurricular activities may be included as the 

last resolution. 

 

Signature of the BoS Chairman                   Signature of the BOS Members 
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Department of Management 

APSCHE COURSE STRUCTURE FOR BBA ACADEMIC YEAR  2025-2026 
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Department of Management 

              Semester-I BBA 

    COURSE STRUCTURE 

 
SL.

NO 
Course 

Name of the Subject and 

code 

 

Course Code Total 

Marks 

Mid 

Exam 

Sem. 

End 

Exam 

Teach

ing 

Hours 

Cre

dits 

1. 
Major Accounting for Managers 

25BBA101T 
100 30 70 4 4 

2. 
Major 

Principles of 

Management 

25BBA102T 
100 30 70 4 4 

3. Skill 
Enhancem

ent Course 

Introduction to Artificial 

Intelligence 

25BCS101S 
25BCS101L 100 - 100 4+2 6 

 

              Semester-II I B.B.A 

        COURSE STRUCTURE 

 
 

SL.

NO 
Course 

Name of the Subject 

and code 

 

Course Code Total 

Marks 

Mid 

Exam 

Sem. 

End 

Exam 

Teach

ing 

Hours 

Credi

ts 

1. 
Major Managerial Economics  

25BBA201T 
100 30 70 4 4 

2. 
Major Business Law 

25BBA202T 
100 30 70 4 4 

3. Skill 

Enhanceme
nt Course 

Artificial intelligence 

25BCS202S 

25BCS202L 50 - 50 2 2 

 

 

     Signature of the Chairman                                            Signature of the BOS Members 
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Department of Management 

Semester-I I B.B.A 

 

COURSE 1: ACCOUNTING FOR MANAGERS 

        Credits: 4                                COURSE CODE: 25BBA101T 4hrs/week  

 

Course Objectives 

  

This course is designed to: 

- Familiarize students with the fundamental principles and concepts of accounting. 

- Equip learners with the skills to prepare and interpret financial statements. 

- Help the students to use accounting information for managerial decision-making. 

- Provide practical exposure to cost and management accounting tools. 

- Develop analytical skills for financial statement analysis and budgeting. 

 

Course Outcomes (COs) 

Upon completion of this course, students will be able to: 

 

CO1:Understand the principles of financial and managerial accounting. 

CO2: Prepare and interpret basic financial statements. 

CO3: Apply cost accounting techniques in managerial contexts. 

CO4: Use financial information for decision-making and control. 

CO5:Analyze financial statements for assessing organizational performance. 
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Department of Management 
Semester-I I B.B.A 

 

COURSE 1: ACCOUNTING FOR MANAGERS 

        Credits: 4                                COURSE CODE: 25BBA101T 4hrs/week  

 

 

Unit I: Introduction to Accounting and Financial Statements 

Meaning, Objectives, Functions and Importance of Accounting – Accounting Concepts and Conventions – 

Users of Accounting Information – Distinction between Financial Accounting, Cost Accounting, and 

Management Accounting – Introduction to Financial Statements: Trading Account, Profit and Loss Account, 

and Balance Sheet – Limitations of Financial Statements (Theory Only) 

Unit II: Financial Statement Analysis 

Meaning and Purpose of Financial Statement Analysis – Types of Analysis: Vertical, Horizontal and Trend 

Analysis (Theory and Simple Problems) 

 

Unit III: Cost – Cost Accounting 

Meaning of Cost and Cost Accounting – Elements of Cost: Direct Material, Direct Labour, Direct Expenses, 

and Overheads – Cost Classification: Fixed, Variable, Semi-variable – Functional Classification of Costs – 

Preparation of Cost Sheet (Theory and Simple Problems) 

 

Unit IV: Marginal Costing and Break-Even Analysis 

Concept of Marginal Cost and Marginal Costing – Contribution – Profit-Volume Ratio – Break- Even Point – 

Margin of Safety – Cost-Volume-Profit (CVP) Analysis (Theory and Simple Problems) 

 

Unit V: Budget and Budgetary Control 

Concept of Budget - Meaning and Objectives of Budgeting – Types of Budgets: Master Budget – Preparation of 

Budgets – Budgetary Control: Meaning, Advantages and Limitations – Zero-Based Budgeting and Performance 

Budgeting (Theory and problem only). 
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Student-Centric Activities 

 Prepare final accounts from a given trial balance and present Trading, Profit& Loss Account, and 

Balance Sheet for a fictional firm. 

 Create a detailed cost sheet using hypothetical data on materials, labor, and overheads to 

understand cost classification. 

 Use Excel to compute and plot Break-even Charts to analyze cost-volume-profit relationships. 

 Form groups to prepare functional budgets (sales, cash, production) and present a comparative 

analysis of budgeted vs. actual figures. 

 Analyze financial statements of a real-life listed company and calculate key financial ratios for 

decision-making insights. 

          

          Reference: 

1. Maheshwari,S.N.&Maheshwari,S.K.(2022).AnIntroductiontoAccountancy.Vikas Publishing 

House. 

2. Jain,S.P.&Narang,K.L.(2022).CostandManagementAccounting.KalyaniPublishers. 

3. Khan,M.Y.&Jain,P.K.(2022).ManagementAccounting.McGrawHillEducation. 

4. Tulsian,P.C.(2022).FinancialAccountingforManagers.PearsonEducation. 

5. Horngren,C.T.,Sundem,G.L.,&Stratton,W.O.(2021).IntroductiontoManagement Accounting. 

Pearson. 
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Department of Management 

 

I B.B.A HONOURS 

SEMESTER –II: COMMERCE PAPER – I 

ACCOUNTING  FOR MANAGERS - I 

  

 

BLUE PRINT FOR THE MODEL PAPER 

 

 

S. 

NO  
 

 

Type of 

Question  
 

 

To be given in the Question Paper  
 

 

To be answered 
 

No. of 

Questions 
 

Marks 

allotted to 

each 

question 
 

Total 

Marks  
 

No. of 

Questions  
 

Marks 

allotted 

to each 

question  
 

Total 

Marks  
 

1 

 

Section - A 

(Short 

Questions) 

10 5 50 5 4 20 

2 Section - B 

(Essay 

Questions) 

10 10 100 5 10 50 

Total Marks 

 

150 Total Marks 70 

 

 

 

 

 

 

25BBA101T 
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Department of Management 
 

I B.B.A HONOURS 

SEMESTER –I: MANAGEMENT PAPER – I 

ACCOUNTING  FOR MANAGERS  

  

I BBA HONOURS  

                                                                                                             
BLUE PRINT FOR THE QUESTION PAPER SETTING 

 

Chapter Name   
 

Short questions 

5 marks   

Essay questions  10 marks  

 

UNIT – I 2 2 

UNIT – II 2 2 

UNIT – III 2 2 

UNIT – IV 2 2 

UNIT – V 2 2 

Total No. of Questions  

 

10 10 

 

 

Signature of the Chairman     Signature of the BOS Members  

           

 

 

25BBA101T 
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     DEPARTMENT OF MANAGEMENT 

I BBA HONOURS 

SEMESTER –I: MANAGEMENT PAPER – I 

Accounting for Managers 

 

Time : 3 hrs                       CODE: 25BBA101T                             Max Marks : 70 

___________________________________________________________________________ 

MODEL QUESTION PAPER 

 

       Answer any Five of the following Questions     5X4 =20 Marks 

 

1. Define Accounting and explain any two of its objectives. 

2. State any four Accounting Concepts. 

3. Distinguish between Cost Accounting and Management Accounting. 

4. What are the limitations of Financial Statements? 

5. Define Vertical Analysis and Horizontal Analysis. 

6. What are the elements of Cost? 

7. Define Marginal Costing. 

8. What is the meaning of Break-Even Point? 

9. Define Budgetary Control. 

10. What is Zero-Based Budgeting? 

                                                               SECTION – B 

 Answer ONE question from each UNIT Each question carries 10 marks            5 × 10 = 50 Marks 

                                                                 UNIT- I 

Q11. Discuss the various users of accounting information. 

                                                                         OR 
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Q12. Explain the functions and importance of Accounting 

                                                                 UNIT - II 

Q13.  What is Financial Statement Analysis? Explain the different types of analysis—Vertical, Horizontal, and 

Trend. 

                                                                            OR 

Q14. The following are sales figures of a company: 

Year 2022 – Rs.1,00,000 

Year 2023 – Rs.1,20,000 

Year 2024 – Rs.1,50,000 

 

Calculate the Trend Percentages taking 2022 as the base year. 

UNIT - III 

Q15. Explain the meaning of Cost Accounting and the different classifications of costs. 

                                                                OR 

Q16. Prepare a Cost Sheet from the following data: 

 

Direct Material – Rs.50,000 

Direct Labour – Rs.30,000 

Direct Expenses – Rs.5,000 

Factory Overheads – Rs.10,000 

Office & Admin Overheads – Rs.8,000 

Selling & Distribution Overheads – Rs.7,000 

Profit – Rs.20,000 

 

Find Prime Cost, Factory Cost, Cost of Production, Cost of Sales, and Selling Price. 

                                 

UNIT- IV 

Q17.  Explain the concept of Marginal Costing and its usefulness in managerial decision-making. 

                                                              OR 

Q18. Given: 

Fixed Cost = Rs.40,000 

Variable Cost per unit = Rs.20 

Selling Price per unit = Rs.30 
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(a) Calculate the Break-Even Point in units and in ₹. 

(b) If sales are Rs.90,000, find the Margin of Safety. 

                                                                         UNIT- V 

Q19. Define Budget and Budgetary Control. Explain its advantages and limitations. 

                                                             OR 

Q20. Prepare a Flexible Budget for 50%, 60%, and 70% capacity from the following data: 

 

Fixed Expenses – Rs.20,000 

Variable Expenses – Rs.30,000 

Semi-Variable Expenses – Rs.10,000 

 

Semi-Variable Expenses increase by 10% for every 10% increase in capacity. 
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     DEPARTMENT OF MANAGEMENT 

 I BBA SEMESTER –I: MANAGEMENT PAPER – II 

COURSE 2: PRINCIPLES OFMANAGEMENT 

 

 

 

      Credits : 04                     Teaching Hrs/Week : 4 

__________________________________________________________________________ 

COURSE 2: PRINCIPLES OFMANAGEMENT 

Theory Credits: 4 4hrs/week 

Course Objectives 

 

      This course is designed to: 

- Introduce the fundamental concepts, functions, and principles of management. 
- To examine the evolution of management thought and understand classical to contemporary 

practices. 
- Equip students with the knowledge of planning, organizing, leading, and controlling functions. 
- Analyze modern management strategies in the context of global challenges. 
- Help students apply management theories and concepts to real-life business scenarios. 
 

Course Outcomes (COs) 

Upon successful completion of the course, the student will be able to: 

CO1: Understand and explain the fundamental principles and practices of management. 

CO2: Comprehend and apply the management process including planning, organizing, leading, and     

           controlling. 

CO3: Analyze different organizational structures and delegation patterns. 

CO4: Evaluate various motivational and leadership theories in organizational contexts. 

CO5: Apply managerial control techniques to enhance organizational productivity and quality. 

Unit I: Introduction to Management 

Definition and nature of management  – Evolution of management thought – Principles of management–

     25BBA102T 
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Functions of management–Levels of management–Roles and responsibilities of managers –– Emerging 

concepts in modern management. 

 

Unit II: Planning 

Nature and significance of planning – Types of planning:– Planning process–Objectives and policies–

Management by Objectives(MBO) –– Advantages and limitations of planning 

 

Unit III: Organizing 

Definition of Organization - Nature and purpose of organizing – Principles of organization – Formal and 

informal organization–Organizational structure: functional, divisional, matrix –Line and staff authority– 

Centralization and decentralization – Delegation of authority – Recent trends in organizational design. 

Unit IV: Staffing and Directing 

Meaning and importance of Staffing and directing – Motivation: meaning, importance, and theories (Maslow, 

Herzberg, McGregor) – Leadership: styles and leadership theories (Trait, Behavioral, Contingency)  

Unit V: Communication and Controlling 

Meaning and Definition of Communication - Communication process – Types of communication – Barriers 

to effective communication and ways to overcome them - Nature and process of control – Types of control: 

feed forward, concurrent, feedback –Budgetary and non-budgetary control techniques– Modern tools of 

managerial control. 

 

Student-Centric Activities 

- Case Study Analysis: Students analyze real-world business cases focusing on planning, organizing, 

or leadership strategies and present their observations and solutions. 

- Management Role Play: Enactment of managerial roles such as planning meetings, staff delegation, 

or conflict resolution to simulate practical management scenarios. 

- Group Debate: Conduct structured debates on topics like “Centralization vs. Decentralization” or 

“Autocratic vs. Democratic Leadership” to foster analytical thinking. 

- Planning Simulation Exercise: Students develop a strategic plan or business model for a hypothetical 

startup, including vision, mission, goals, and organizational structure. 

- Leadership Style Self-Assessment: Students take aleadership personality quiz and reflect on their 

style with examples of how it aligns with famous managerial theories. 

 

            

           Recommended Text books 
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1. Gupta,Sharma,&Bhalla.PrinciplesofBusinessManagement.KalyaniPublications,1st Edition. 
2. L.M.Prasad. Principles of Management. Sultan Chand & Sons, Latest Edition. 
3. Koontz,H.,&Weihrich,H.EssentialsofManagement.TataMcGraw-Hill,1998. 
4. Joseph L.Massie. Essentials of Management. Prentice Hall(Pearson),4thEdition,2003. 
5. Tripathi,P.C.,&Reddy,P.N. Principles of Management. Tata McGraw-Hill. 
6. J.N. Chandan. Management: Theory and Practice. 
7. J.S.Chandan. Management: Concepts and Strategies, Vikas Publishing. 
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Department of Management 

 

I B.B.A HONOURS 

SEMESTER –II: MANAGEMENTPAPER – II 

PRINCIPLES OF MANAGEMENT  

 

BLUE PRINT FOR THE MODEL PAPER 

 

 

S. 

NO  
 

 

Type of 

Question  
 

 

To be given in the Question Paper  
 

 

To be answered 
 

No. of 

Questions 
 

Marks 

allotted to 

each 

question 
 

Total 

Marks  
 

No. of 

Questions  
 

Marks 

allotted 

to each 

question  
 

Total 

Marks  
 

1 

 

Section - A 

(Short 

Questions) 

10 5 50 5 4 20 

2 Section - B 

(Essay 

Questions) 

10 10 100 5 10 50 

Total Marks 

 

150 Total Marks 70 

 

 

 

 

 

 

25BBA102T 
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Department of Management 
 

I B.B.A HONOURS 

SEMESTER –I: MANAGEMENT PAPER – II 

PRINCIPLES OF MANAGEMENT  

 

                                                                                                          

BLUE PRINT FOR THE QUESTION PAPER SETTING 

 

Chapter Name   
 

Short questions 

5 marks   

Essay questions  10 marks  

 

UNIT – I 2 2 

UNIT – II 2 2 

UNIT – III 2 2 

UNIT – IV 2 2 

UNIT – V 2 2 

Total No. of Questions  

 

10 10 

 

 

Signature of the Chairman     Signature of the BOS Members  

           

 

 

 

25BBA102T 
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     DEPARTMENT OF MANAGEMENT 

I BBA HONOURS 

SEMESTER –I: MANAGEMENT PAPER – II 

PRINCIPLES OF MANAGEMENT 

Time : 3 hrs                       CODE: 25BBA102T                             Max Marks : 70 

___________________________________________________________________________ 

MODEL QUESTION PAPER 

 

       Answer any Five of the following Questions     5X4 =20 Marks 

 

SECTION – A 

Answer any FIVE of the following Questions                                           5 × 4 = 20 Marks 

1. Define Management and explain its nature. 

2. State any four principles of Management. 

3. What are the functions of Management? 

4. Define Planning and state its importance. 

5. What is Management by Objectives (MBO)? 

6. Distinguish between Formal and Informal Organization. 

7. What are the main features of Leadership? 

8. Write a short note on Maslow’s Need Hierarchy Theory. 

9. What are the barriers to effective communication? 

10. Explain the types of control in Management. 

SECTION – B 

Answer any ONE question from each Unit of the following Questions5 × 10 = 50 Marks 
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UNIT – I 

Q11. Explain the evolution of management thought and discuss the roles and responsibilities of managers in 

modern organizations. 

OR 

Q12. Discuss the various levels of management and the functions performed at each level. 

UNIT – II 

Q13. Explain the nature, importance, and process of planning. 

OR 

Q14. What is Management by Objectives (MBO)? Explain its features, advantages, and limitations. 

UNIT – III 

Q15. Define organizing. Explain the different types of organizational structures with suitable examples. 

OR 

Q16. What is Delegation of Authority? Explain the differences between centralization and decentralization. 

UNIT – IV 

Q17. Explain the importance of motivation and describe Herzberg’s Two-Factor Theory. 

OR 

Q18. What is Leadership? Explain various leadership styles and theories. 

UNIT – V 

Q19. Define Communication. Explain the communication process and the ways to overcome barriers. 

OR 

Q20. Explain the process and techniques of managerial control. Discuss modern tools of control. 
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DEPARTMENT OF COMMERCE 

Common to All Groups – Semester I 
SEMESTER –I:  SKILLPAPER  

 

 
CourseCode TitleoftheCourse L S/M P C 

25BCS101S AI Fundamentals    4  4 

Prerequisites Basics of Computers 

 

COURSE OBJECTIVES 

1 Understand the history and evolution of Artificial Intelligence and Identify major subfields of AI. 

2 Investigate the role of AI in various industries like healthcare, agriculture, and education. 

3 Examine concepts like bias, fairness, transparency, and accountability in AI systems. 

4 
Explore the integration of AI in scientific research and discuss future directions and evolving 

trends in AI. 

5 Learn how prompt engineering is used in various sectors like education and content creation. 

 

COURSE OUTCOMES 
BTL 

Upon successful completion of the course, the student will be able to: 

CO1 
Describe the different subfields and their roles in AI applications. 

Understanding 

CO2 
Summarize the benefits and limitations of AI in diverse domains. 
 

Understanding 

CO3 Operate AI systems in terms of inclusivity, privacy, and robustness. Applying 

CO4 Practice Generative AI and emerging technologies like ChatGPT. Applying 

CO5 Apply prompt engineering concepts to various real-world use cases. Applying 
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DEPARTMENT OF COMMERCE 

SEMESTER –I:  SKILLPAPER  
ARTIFICIAL INTELIGENCE FUNDAMENTALS  

Syllabus 

 

COURSE CONTENT 

UNIT I 

Introduction to Artificial Intelligence: History, Definition, Artificial General 

Intelligence, Challenges in AI. Knowledge Engineering, Machine Learning, Computer 

Vision, Natural Language Processing, Robotics. 

UNIT II Applications of AI: Healthcare, Finance, Retail, Agriculture, Education, Transportation. 

UNIT III 

Bias and Fairness in AI Systems: Ethics in AI, Bias and Fairness in AI Systems, Transparency 

in AI Systems, Accountability, Security, Privacy, Inclusivity, Sustainability, Robustness, 

Reliability. 

UNIT IV 

AI in Research, Generative AI and prompt engineering: AI in Experimentation and 

Multi-disciplinary research, Generative AI introduction, ChatGPT, Hugging Face, 

Gemini, Copilot, Perplexity. 

UNIT V 

Prompt engineering: Prompt engineering Definition and its importance, Role of Prompt 

Engineering in AI/ML Interaction. 

Applications of Prompt Engineering: Education, Business & Commerce,  

Content Creation: AI for Creative Writing, AI for creative design, writing AI scripts for 

video, generating slides and slidesGPT usage. 

 

 

TEXT BOOKS 

1. 
AI for Everyone: A Beginner's Handbook for Artificial Intelligence (AI) by Saptarsi Goswami, Amit 

Kumar Das, Amlan Chakrabarti 

2. Prompt Engineering for Beginners: by Kapila Arora, Geetu Garg, Gaurav Arora. 
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REFERENCE BOOKS 

1. Let’s Learn Artificial Intelligence: Base Module, Niti Ayog, Atal Innovation Mission. 

2. 
Prompt Engineering for Generative AI: Future-proof inputs for Reliable AI-outputs by James 

Phoenix & Mike Taylor. 

3. 
Generative AI 360°: Practical Guide to ChatGPT, Midjourney & AI Tools to Boost Productivity 

&Creativity, For Professionals, Marketers & Entrepreneurs by Hitesh Motwani,Zebra Learn, 2025. 

WEB RESOURCES 

1. 

Learn Generative AI Prompt Engineering for everyone. https://www.coursera.org/learn/generative-ai-

prompt-engineering-for-everyone?action=enroll 

 

2. 

Generative AI Tutorial:https://www.w3schools.com/gen_ai/ 

 

3. 

Free Artificial Intelligence (AI) Tutorial - Hands-On Prompt Engineering for AI Beginners & Business User | 

Udemy, https://www.udemy.com/course/prompt-engineering-for-ai-beginners-business-users 

 

 

 

CO-POMapping:  

 

  PO1 PO2 PO3 PO4 PO5 PO6 PO7 PO8 PO9 PO10 PSO1 PSO2 PSO3 PSO4 

CO1 1 1 1 2 2 1 0 0 1 0 1 0 1 0 

CO2 1 1 1 2 2 1 0 0 1 0 1 0 1 0 

CO3 1 1 1 3 2 2 2 1 2 2 3 1 3 0 

CO4 2 2 1 3 3 2 2 1 3 2 3 1 3 1 

CO5 2 2 1 3 2 2 2 1 2 2 3 1 3 1 

https://www.coursera.org/learn/generative-ai-prompt-engineering-for-everyone?action=enroll
https://www.coursera.org/learn/generative-ai-prompt-engineering-for-everyone?action=enroll
https://www.w3schools.com/gen_ai/
https://www.udemy.com/course/prompt-engineering-for-ai-beginners-business-users
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DEPARTMENT OF COMMERCE 

SEMESTER –I:  SKILLPAPER  
ARTIFICIAL INTELIGENCE FUNDAMENTALS  

Model Blueprint for the question paper setter 

 

Sl. No. UNIT- Essay 10M Weightage 

1 I 2 20% 

2 II 2 20% 

3 III 2 20% 

4 IV 2 20% 

5 V 2 20% 

  100 100% 
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AI Fundamentals- Common to all Groups 

Semester-I 
Recommended Format of Question Paper for all Courses 

                              Time: 3 Hours                                                                                        Max. Marks: 70 

Section-A 

       Answer any FIVE of the following questions.    5X4=20 

From Contents of Unit-I 
From Contents of Unit-I 
From Contents of Unit -II 
From Contents of Unit -II 
From Contents of Unit -III 
From Contents of Unit -III 
From Contents of Unit -IV 
From Contents of Unit -IV 
From Contents of Unit -V 
From Contents of Unit -V 

Section-B 

Answer FIVE questions.        5X10=50 
A) From Contents of Unit-I 
OR 
B) From Contents of Unit-I 
A) From Contents of Unit-II 
 OR 
B) From Contents of Unit -II 
A) From Contents of Unit -III 
OR 
B) From Contents of Unit -III 
A) From Contents of Unit -IV 
OR 
B) From Contents of Unit -IV 
A) From Contents of Unit -V 
OR 
B) From Contents of Unit –V 
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AI FUNDAMENTALS 
MODEL QUESTION PAPER (W.E.F 2025-2026)  

 Common to All Groups 

Time: 3Hrs.                                                                                             Marks:70 

 

 

 

 

 

 

 

Q. No Question Marks BL CO PO PI 

SECTION – A 

Answer any Five of the Following 5 X 4 = 20M  

1 Explain about Machine Learning. 4M 2 1   

2 Discuss about Robotics. 4M     2 1   

3 Illustrate the AI applications in Finance sector 4M 2 2   

4 Explain how AI can be applied in transportation. 4M 2 2   

5 What is ethics in AI? 4M 1 3   

6 Discuss about Accountability and Security in AI 
Systems. 

4M 2 3   

7 How is Copilot used? 4M 2 4   

8 What is Hugging face? 4M 1 4   

9 Define prompt engineering. 4M 1 5   

10 What are the applications of Prompt engineering in 
Education? 

4M 1 5   
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Common to All Groups – Semester I 

CourseCode TitleoftheCourse L T P C 

25BCS101L AI FUNDAMENTALS   2 0 

Prerequisites Basic Computer Knowledge 

 

Practice Session 
1.Create a mind map of AI subfields: NLP, CV, ML, Robotics, Knowledge Engineering using Canva/Napkin AI/ 
Similar Open AI tool  
2. Text Analysis with Open-Source NLP Tools: Tool: Voyant Tools (text analysis web app)  
● Input sample texts (e.g., news articles, speeches).  
● Explore word frequency, keywords, sentiment.  
● Understand how NLP extracts meaning from text.  
3. Train a basic image classifier using webcam images. Observe how the model "learns." Using Google Teachable 
Machine  
● Train two image categories (e.g., “Smiling” vs. “Not Smiling”) using their own webcam images.  
● Observe how the model learns to classify.  
● Now try feeding images of people with different skin tones, facial features, etc.  
● Observe misclassifications or differences in confidence.  
4. Simulate an AI chatbot helping a farmer or a student. You may use any GenAI tool of your choice. You may use 
the prompt below and also try your own.  
Prompt:  
“Act as an agriculture assistant. A farmer wants to know the best crop based on soil and season. Ask questions 
and suggest crops.”  
 
5. Test Generative AI- Generate a poem or image from prompt “A futuristic green city.” using ChatGPT, Hugging 
Face (e.g., image or text generation)  
6. Observe how generative AI models may show biased results when prompted with neutral profession 
descriptions. (Bing Image Creator / DALL·E on ChatGPT/ChatGPT). Generate images using the following neutral 
prompts:  
● “A doctor treating a patient”  
● “A teacher in a classroom”  
● “A CEO giving a speech”  
● “A software engineer working from home” Observe and discuss:  
● What gender/race/age are most commonly shown?  
● Are the results stereotypical or diverse?  
7. Check how language models may express bias depending on names, ethnicity, or location.  
Use Chat GPT or Gemini  
Prompts:  
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Prompt A:  
“A person named Raj is applying for a bank loan. Will he be approved?”  
Prompt B: 
“A person named John is applying for a bank loan. Will he be approved?”  
Change names, genders, and nationalities.  
Observe the following and report your findings:  
● Are the responses different?  
● Is one version more positive or negative?  
● Does the model express bias or hesitate?  
● Should AI make such predictions?  
● How do developers prevent this?  
 
8. Exploring Text Generation and Summarization with Google AI Studio  
Generate Creative Content  
“Write a short story (150 words) about a robot who wants to become a chef.”  
● Submit and read the AI-generated story.  
● Discuss how detailed and creative the output is.  
Summarize a Paragraph  
Prompt:  
Summarize the following paragraph in 3 sentences:  
“Artificial Intelligence is a branch of computer science that aims to create intelligent machines that can mimic 
human thinking. It includes various subfields like machine learning, natural language processing, and robotics. AI 
is widely used in industries such as healthcare, finance, and transportation to improve efficiency and decision-
making.”  
● Submit and review the summary.  
● Evaluate how well AI extracts key points.  
Refine Your Prompt  
Try changing the summary prompt to:  
“Summarize the paragraph above in simple language for 10-year-olds.”  
● Compare this output to the previous one. 
● Note how prompt wording changes results.  
9. AI for Creative Writing  
Prompt:  
“Write a short motivational story for 10-year-old students in under 150 words.”  
10. Generate Slides: Tool: SlidesGPT/ Another Free AI tool  
Prompt:  
“Create a 5-slide presentation on ‘AI in Smart Farming’.”  
 
11. YouTube Thumbnails / Branding: Tool: Canva + Magic Media AI  
Design a thumbnail using Canva’s AI tools with a prompt like:  
“Design a YouTube thumbnail for a video titled ‘Top 5 AI Tools for Students’.” 
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    DEPARTMENT OF MANAGEMENT 

I BBA SEMESTER –II  

                                          COURSE STRUCTURE 

 
 

SL.

NO 
Course 

Name of the subject and 

code 

 

 

Course Code 

Total 

Marks 

Mid 

Exam 

Sem. 

End 

Exam 

Teach

ing 

Hours 

Cre

dits 

1. 
Major Managerial Economics  

25BBA203T 
100 30 70 4 4 

2. 
Major Business Laws 

25BBA204T 
100 30 70 4 4 

2. Skill 

Enhanceme
nt Course 

Artificial intelligence 

25BBA202T 

25BBA202L 100 - 50 4+2 6 

 

 

Signature of the Chairman     Signature of the BOS Members 
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     DEPARTMENT OF MANAGEMENT 

I BBA SEMESTER –II: MANAGEMENT PAPER - III 

 

 

      Credits : 04                     Teaching Hrs/Week : 4 

__________________________________________________________________________ 

SEMESTER-II 

COURSE 3 : MANAGERIAL ECONOMICS 

         Course Objectives 

          This course is designed to: 

- Familiarize students with the application of economic principles to managerial decisions. 
- Enable students to analyze demand, supply, and consumer behavior using economic tools. 
- Apply optimization techniques (e.g., derivatives)in managerial problem-solving. 
- Understand pricing strategies and production decisions under different market conditions. 
- Introducemacroeconomicindicatorsrelevanttobusinessdecisionsandpolicy 

environments. 
 

Course Outcomes (COs) 

Upon successful completion of this course ,students will be able to: 

CO1:Underst and apply core concept of managerial economics in decision-making. 

CO2:Analyze consumer behavior, demand elasticity, and supply responses. 

CO3:Utilize marginal analysis and optimization techniques in pricing and output decisions. 

CO4:Examine cost structures and production behavior in the short and long run. 

CO5:Evaluate market structures and macro economic indicators affecting business performance. 

 

Unit I: Introduction to Managerial Economics 

Definition, nature, and scope of managerial economics – Role of managerial economics in decision-

making – Microeconomics vs. Macroeconomics – Basic principles: Opportunity Cost Principle, 

     25BBA203T 
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Incremental Principle, Discounting Principle– Application of managerial economics in business 

problems. 

 

 

Unit II: Demand, Supply and Consumer Behavior (Basics) 

Definition of Demand - Law of demand and determinants of demand – Elasticity of demand: Price, 

Income, and Cross Elasticity – Measurement of elasticity – Factors affecting elasticity – Law of supply– 

Demand forecasting: (conceptual overview only). 

 

Unit III: Utility Theory  

Cardinal Utility Approach: Total utility and Marginal Utility – Law of Diminishing Marginal Utility – 

Law of Equi-Marginal Utility – Ordinal Utility Approach: Indifference Curve Analysis – Marginal Rate 

of Substitution. 

Unit IV: Production, Cost and Market Structures 

Production Function – Fixed and Variable Inputs – Laws of Production: Law of Variable Proportion and 

Returns to Scale – Cost Concepts: Explicit, Implicit, Private, and Social Costs – Cost Curves in Short 

and Long Run – Economies and Diseconomies of Scale – Market Structures: Features and Pricing under 

Perfect Competition, Monopoly, Monopolistic Competition, and Oligopoly. 

 

Unit V: Macro economic Analysis for Managers 

National Income Concepts: GDP, GNP, NDP, NNP, and Methods of Calculation (overview) – Theories 

of Income and Employment:– Business Cycles and their Impact on Business – Relevance of 

Macroeconomic Indicators in Managerial Decision- making . 

 

 

Student-Centric Activities 

- Elasticity Case Study: Analyze demand elasticity for real-life products. 
- Consumer Choice Simulation: Model consumer equilibrium using budget lines. 
- Cost Curve Plotting: Prepare cost curves using sample industry data. 
- Market Structure Role Play: Enact pricing strategies under different markets. 
- Economic Indicator Report: Present business impact of GDP, inflation, etc. 

 

 Recommended Text books and Readings 
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1. Ivan Png (2021).Managerial Economics. Blackwell Publishers. 

2. Dominick Salvatore (2022). Managerial Economics in a Global Economy. 

Cengage/Thomson South-Western. 

3. Paul G. Keat & Philip K. Y. Young (2022). Managerial Economics: Economic Tools for 

Today’s Decision Makers. Pearson. 

4. D.N. Dwivedi(2022).Managerial Economics. Vikas Publishing House. 

5. L.Varshney &K.L. Maheshwari(2022).Managerial Economics. Sultan Chand & Sons. 

6. Lipsey & Chrystal (2022). Economics. Oxford University Press. 
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Department of Management 

 

I B.B.A HONOURS 

SEMESTER –II: MANAGEMENTPAPER – II 

MANAGERIAL ECONOMICS - 25BBA203T  

BLUE PRINT FOR THE MODEL PAPER 

 

 

S. 

NO  
 

 

Type of 

Question  
 

 

To be given in the Question Paper  
 

 

To be answered 
 

No. of 

Questions 
 

Marks 

allotted to 

each 

question 
 

Total 

Marks  
 

No. of 

Questions  
 

Marks 

allotted 

to each 

question  
 

Total 

Marks  
 

1 

 

Section - A 

(Short 

Questions) 

10 5 50 5 4 20 

2 Section - B 

(Essay 

Questions) 

10 10 100 5 10 50 

Total Marks 

 

150 Total Marks 70 
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Department of Management 
 

I B.B.A HONOURS 

SEMESTER –I: MANAGEMENT PAPER – II 

MANAGERIAL ECONOMICS 25BBA203T  

                                                                                                     

BLUE PRINT FOR THE QUESTION PAPER SETTING 

 

Chapter Name   
 

Short questions 

5 marks   

Essay questions  10 marks  

 

UNIT – I 2 2 

UNIT – II 2 2 

UNIT – III 2 2 

UNIT – IV 2 2 

UNIT – V 2 2 

Total No. of Questions  

 

10 10 

 

 

Signature of the Chairman     Signature of the BOS Members  
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     DEPARTMENT OF MANAGEMENT 

I BBA HONOURS 

SEMESTER –I: MANAGEMENT PAPER – II 

MANAGERIAL ECONOMICS 

Time : 3 hrs                       CODE: 25BBA203T                             Max Marks : 70 

___________________________________________________________________________ 

MODEL QUESTION PAPER 

SECTION – A 

 

                     Answer any Five of the following Questions     5X4 =20 Marks 

 
1. Define Managerial Economics and explain its nature and scope. 

2. Explain the role of Managerial Economics in decision-making. 

3. Differentiate between Microeconomics and Macroeconomics. 

4. What is the Opportunity Cost Principle? Give its significance. 

5. State the Law of Demand and explain its determinants. 

6. What are the main factors affecting Elasticity of Demand? 

7. Explain the Law of Diminishing Marginal Utility. 

8. Distinguish between Perfect Competition and Monopoly. 

9. What are the main types of Market Structures? 

10. Explain the importance of National Income concepts in business decision-making. 
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SECTION – B 

  Answer any one from each Unit of the following Questions                                        (5 × 10 = 50 Marks) 

UNIT – I 

Q11. Discuss the nature, scope, and importance of Managerial Economics. 

     OR 

Q12. Explain the basic principles of Managerial Economics with suitable examples. 

 

UNIT – II 

Q13. Describe the Law of Demand and the factors influencing it. 

OR 

Q14. What is Elasticity of Demand? Explain its types and importance. 

UNIT – III 

Q15. Explain the Law of Equi-Marginal Utility and its importance in consumer behavior. 

OR 

Q16. Discuss the differences between Cardinal and Ordinal Utility approaches. 

UNIT – IV 

Q17. Explain the Laws of Production and their managerial applications. 

OR 

Q18. Discuss the features and pricing strategies under Perfect Competition and Monopoly. 

UNIT – V 

Q19. Explain the various concepts of National Income and their relevance in business. 

OR 

Q20. Discuss the phases of Business Cycles and their impact on managerial decisions. 
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DEPARTMENT OF MANAGEMENT 

I BBA HONOURS 

SEMESTER –II: MANAGEMENT PAPER – IV 

 

SEMESTER-II COURSE 4: BUSINESSLAW 
       

               Course Objectives(COs) 

               This course is designed to: 

- Understand the foundational principles of contracts under the Indian Contract Act,1872. 
- Analyze the legal elements that make a contract valid, enforceable, and binding. 
- Understand the legal capacity of parties and the rules governing contingent contracts and 

contract discharge. 
- Examine the relevance of contemporary laws like the Sale of Goods Act, Consumer 

Protection Act, and IT Act in modern business practices. 
- Identify types of cyber crimes and explain the scope, objectives, and legal provisions of the IT 

Act 2000. 

Course Outcomes(COs) 

CO1: Understand the essential elements and classifications of contracts under the Indian Contract Act, 

1872. 

CO2: Identify and evaluate the legal validity of offer, acceptance, and consideration in contract formation. 

CO3: Examine the legal rules related to party capacity, contingent contracts, and remedies for breach. 

CO4: Analyze the rights and duties under the Sale of Goods Act and the mechanisms of consumer 

protection. 

CO5:Explain the scope of the IT Act 2000 and apply cyber safety measures and reporting procedures for 

cybercrimes. 

 

Unit I: Law of Contract 

Introduction to the Indian Contract Act, 1872 - Meaning and definition of Agreement and Contract – Essential 

elements of a valid contract – Types of contracts: Valid, Void, Voidable  

 

Unit II: Offer, Acceptance and Consideration 

     25BBA204T   
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Definition of a valid offer, acceptance and consideration – legal rules relating to valid offer, acceptance and 

consideration  

 

Unit III: Capacity of the Parties and Contingent Contract 

Capacity of the Parties – Minor contract - Legal rules relating to minor contract– Contingent contracts – Legal 

rules relating to contingent contracts –Modes of Discharge of Contracts: – Remedies available for breach of 

contract. 

Unit IV: Sale of Goods Act, 1930 and Consumer Protection Act, 2019 

Definition of Sale Contract - Sale vs. Agreement to Sell – Implied Conditions and Warranties – Rights of an 

unpaid seller – Introduction to Consumer Protection Act, 2019 – Definitions: Consumer, Goods, Services, 

Complaint, Consumer Dispute – Consumer Rights and Responsibilities – Consumer Protection Councils and 

Consumer Disputes Redressal Forums. 

 

Unit V: Information Technology Act, 2000 

Introduction to Cyber Laws – Types of cybercrimes: hacking, phishing, identity theft, cyber stalking, data 

breaches – Need for cyber legislation in India – Scope and objectives of IT Act 2000 – Digital signatures and 

authentication – Cyber security safety mechanisms – Legal remedies and reporting procedures for 

cybercrimes. 

Suggested Student Activities 

Role Play: Enact simple business contracts demonstrating all essential elements; classify them as valid, void, 

or voidable. 

Case Analysis: Evaluate real or hypothetical cases regarding the validity of offer and acceptance. 

Debate: Debate on the pros and cons of allowing minors to enter into contracts. 

Complaint Simulation: Draft and present a mock complaint under the Consumer Protection Act. 

Poster/Presentation: Design posters or slides highlighting types of cybercrimes, safety tips, and legal 

remedies. 

      Recommended Books and References 

1. J. Jaysankar– Business Laws, Margham Publications, Chennai 

2. N.D.Kapoor– Business Laws, S. Chand Publications 

3. V. Balachandran–BusinessLaw,Tata McGraw Hill 

4. Tulsian–Business Law,Tata McGraw Hill 

5. Pillai & Bhagavathi–Business Law, S.Chand Publication 
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DEPARTMENT OF MANAGEMENT 

I BBA HONOURS 

SEMESTER –II: MANAGEMENT PAPER – IV 
COURSE 4: BUSINESSLAW 

 

 

BLUE PRINT FOR THE MODEL PAPER 

 

 

S. 

NO  
 

 

Type of 

Question  
 

 

To be given in the Question Paper  
 

 

To be answered 
 

No. of 

Questions 
 

Marks 

allotted to 

each 

question 
 

Total 

Marks  
 

No. of 

Questions  
 

Marks 

allotted 

to each 

question  
 

Total 

Marks  
 

1 

 

Section - A 

(Short 

Questions) 

10 5 50 5 4 20 

2 Section - B 

(Essay 

Questions) 

10 10 100 5 10 50 

Total Marks 

 

150 Total Marks 70 
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 DEPARTMENT OF MANAGEMENT 

 I BBA SEMESTER –II: MANAGEMENT PAPER - II 

 
COURSE 4: BUSINESSLAW 

 

 

BLUE PRINT FOR THE QUESTION PAPER SETTING 

 

Chapter Name   
 

Short questions 

5 marks   

Essay questions  10 

marks  

 

UNIT – I 2 2 

UNIT – II 2 2 

UNIT – III 2 2 

UNIT – IV 2 2 

UNIT – V 2 2 

Total No. of Questions  

 

10 10 

 

 

                    Signature of the  Chairman   Signature of the BOS Members 

         

 

                                         

 

     25BBA204T   
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DEPARTMENT OF MANAGEMENT 

I BBA SEMESTER –IV 

 MANAGEMENT PAPER - II 

 

SEMESTER-II COURSE 4: BUSINESS LAW                      

 

                 Time : 3 Hrs                                   CODE: 25BBA204T                                Max Marks : 70   

___________________________________________________________________________ 

MODEL QUESTION PAPER 

 

       Answer any Five of the following Questions     5X4 =20 Marks 

 

1. Define Contract and distinguish it from an Agreement. 

2. Explain the essential elements of a valid contract. 

3. What are the different types of contracts? 

4. Define Offer. What are the legal rules relating to a valid offer? 

5. Define Consideration. What are the legal rules relating to consideration? 

6. Who are competent to contract under the Indian Contract Act, 1872? 

7. Explain the legal rules relating to a minor’s contract. 

8. Distinguish between Sale and Agreement to Sell. 

9. What are the rights of an unpaid seller under the Sale of Goods Act, 1930? 

10. What are the main objectives of the Information Technology Act, 2000? 

  25BBA204T   
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SECTION – B 

Answer any one question from each Unit  (5 × 10 = 50 Marks) 

 
UNIT – I 

Q11. Explain the essential elements of a valid contract under the Indian Contract Act, 1872. 
 
                                                                  OR 
Q12. Discuss the different types of contracts with suitable examples. 
 

UNIT – II 
Q13. Define Offer. Explain the legal rules. 
OR 
Q14. Discuss the importance of Consideration in a valid contract with examples. 
 

UNIT – III 
Q15. Who are the parties competent to contract? Explain the position of a minor’s contract. 
OR 
Q16. What are contingent contracts? Explain their essential legal rules and conditions for validity. 
 

UNIT – IV 
Q17. Explain the rights of an unpaid seller under the Sale of Goods Act, 1930. 
OR 
Q18. Discuss the rights and responsibilities of consumers under the Consumer Protection Act, 2019. 
 

UNIT – V 
Q19. What are the objectives and scope of the Information Technology Act, 2000? 
OR 
Q20. Explain the types of cybercrimes and suggest preventive measures for cyber safety. 
 
 

 

 

 

 

 

 

 

 

 

 

 

 

 



47 

 

             

Applicable To Commerce and Management– Semester II 

 
Course Code Title of the Course L S/M P C 

25BCG202S 
25BCC202S 
25BBA202S 
25BFS202S 

 

Applications of Artificial Intelligence 

  

3 

  
3 

Prerequisites Basics of Artificial Intelligence 

 

COURSE OBJECTIVES 

1 
Provide a foundation in the AI ecosystem, including hardware, cloud, and edge platforms 
relevant to commerce and management. 

2 
Familiarize students with different types of datasets and public repositories used in AI 
research. 

3 
Develop skills in building AI data pipelines through collection, annotation, cleaning, and 
preprocessing. 

4 
Understand how AI enhances retail and e-commerce and explore personalization, 
recommendation systems, and customer engagement. 

5 
Apply AI to streamline business processes and decision-making and explore AI in finance, HR, 
and supply chain management. 

 

COURSE OUTCOMES 
BTL 

Upon successful completion of the course, the student will be able to: 

CO1 
Explain the AI ecosystem (hardware, cloud, and edge devices) and its 
relevance to commerce and management. 

Understanding 

CO2 
Differentiate between structured and unstructured data, and utilize 
public datasets for business-oriented AI applications. 

Understanding 

CO3 
Implement a conceptual AI data pipeline for solving real-world 
problems in commerce and management. 

Applying 

CO4 
Understand and apply AI technologies to improve customer 
engagement and personalization in commerce. 

Understanding 

CO5 
Use AI tools to streamline business operations, enhance decision-
making, and detect patterns in data. 

Applying 
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Applicable To Commerce and Management– Semester II 

Syllabus 

 

COURSE CONTENT 

UNIT I 

Infrastructure and Platforms for Building Applications using AI: 
 

Hardware used in building AI applications: Processors - CPU, GPU, TPU, NPU, Memory - RAM, VRAM, 
Storage - HDD, SSD  
Platforms for building applications using AI: Online platforms (Example - Google AutoML, H2O.ai; 
Desktop (No-code/Low code) platforms (Orange Data Mining, KNIME.  
Edge AI: Concept; Applications in daily life in devices like Refrigerators, Led Bulbs, Surveillance 
Cameras, Micro Ovens, Smart Cars/Scooters; Edge AI in smart Appliances. 

UNIT II 

Foundations of Data - Types, Ethics and Utility in Building Applications using AI: 

 

Importance of data in building AI applications: Data as the fuel for AI, Role of big data in training AI 
models.  
Conceptual Foundations of Data: Data vs. Information vs. Knowledge.  
Structure of Data: Structured, Semi-Structured, and Unstructured Data.  
Modalities of Data: Text, Image, Audio, Video, Tabular. 
Formats of Data: Text Formats (CSV, JSON, XML), Image Formats (JPEG, GIF, PNG), Audio/Video 
(MP3, WAV, MP4, AVI).  
Data Repositories: Definition of public Datasets; Definition of private Datasets; Importance of Public 
Datasets, Popular Public Dataset Repositories (Example - Kaggle, Google Dataset Search or similar 
ones - for demonstration only), Dataset licensing and usage rights.  
Ethics, Privacy in Data Usage: Privacy concerns related to data usage; Ethical use of data, 
Responsible AI data practices. 

UNIT III 

The AI Data Pipeline: From Collection to Model Readiness: 
The AI Data Pipeline: Stages and Components: Key Stages (Data Collection, Annotation, 
Preprocessing, Splitting, Feeding into AI Models  
Core Components: Ingestion, Storage, Processing, Validation, Delivery  
Data Collection Methods for AI: Manual Input (Surveys, forms, human-curated entries), Sensors & 
IoT Devices (Real-time data from physical environments), System Logs & Transactions, Web Scraping 
(Automated extraction from websites), APIs (Structured data access from external platforms)  

Data Annotation and Labelling: Definition & Importance; Annotation Methods: Manual 
Annotation, Automated Annotation;  
Data Cleaning and Preprocessing: Importance of data cleaning; Understanding “Dirty” Data: 
Missing Values, Duplicates, Incorrect Formats, Outliers, Noise; Steps in Data Cleaning: 
Identify Issues, Handle Errors (Imputation, Removal), Validate Cleaned Data.  
Data Splitting: Splitting data into training set and test set.  
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Data Transformation Techniques: Normalization, Transformation. 

UNIT IV 

AI in Commerce – Transforming the Consumer Experience  
 
Introduction to AI in Commerce, Recommendation Engines (Collaborative & Content-Based), 
Chatbots and Virtual Assistants, Sentiment Analysis and Review Mining, Inventory Optimization and 
Demand Forecasting, Ethical Issues related to use of AI in Commerce and Business: Bias, Privacy, and 
Transparency. 

UNIT V 

AI in Business Operations – Driving Efficiency and Insight: 
AI in Business Intelligence and Predictive Analytics, Financial Applications: Fraud Detection, Risk 
Modelling, HR Applications: Resume Screening, Employee Analytics, Supply Chain Automation and 
Optimization, AI in Marketing: Customer Segmentation, Lead Scoring, Strategic Adoption of AI in 
Enterprises, Explainable AI in E-Commerce. 

 

TEXT BOOKS 

1. 
Data Science for Beginners, Andrew Park (Introductory concepts of data types, collection, 
cleaning, and visualization without coding) 

2. 
AI Basics for Non-Programmers, Tom Taulli (Clear explanations of AI data lifecycle and real-world 
use cases). 

REFERENCE BOOKS 

1. 
Data Preparation for Machine Learning, Jason Brownlee (Conceptual understanding of dataset 
quality, preprocessing, and pipelines). 

2. 
Hands-On Data Science for Non-Programmers, David Meerman Scott  
(Spreadsheet-based data exploration and visualization). 

3. You Look Like a Thing and I Love You – Janelle Shane 

WEB RESOURCES 

1. Kaggle Dataset Search, https://www.kaggle.com/datasets 

2. Google Dataset Search, https://datasetsearch.research.google.com 

3. UCI Machine Learning Repository, https://archive.ics.uci.edu 

4. Hugging Face Datasets, https://huggingface.co/datasets 

5. Open Government Data (India), https://data.gov.in 

 

CO-POMapping:  

 

  PO1 PO2 PO3 PO4 PO5 PO6 PO7 PO8 PO9 PO10 PSO1 PSO2 PSO3 PSO4 

CO1 1 1 1 2 2 1 0 0 1 0 1 0 1 0 

CO2 1 1 1 2 2 1 0 0 1 0 1 0 1 0 

CO3 1 1 1 3 2 2 2 1 2 2 3 1 3 0 

CO4 2 2 1 3 3 2 2 1 3 2 3 1 3 1 

CO5 2 2 1 3 2 2 2 1 2 2 3 1 3 1 

https://www.kaggle.com/datasets
https://datasetsearch.research.google.com/
https://archive.ics.uci.edu/
https://huggingface.co/datasets
https://data.gov.in/
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Applicable To Commerce and Management– Semester II 

Model Blue print for the question paper setter 

 

Sl. No. UNIT- Essay 10M Weightage 

1 I 2 20% 

2 II 2 20% 

3 III 2 20% 

4 IV 2 20% 

5 V 2 20% 

  100 100% 
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Applicable To Commerce and Management- 

Semester-II 
 

Recommended Format of Question Paper  

     Time: 2½Hrs           Max. Marks: 70 

Section-A 

Answer any FIVE of the following questions.        5X4=20 

1. From Contents of Unit-I 

2. From Contents of Unit-I 

3. From Contents of Unit -II 

4. From Contents of Unit -II 

5. From Contents of Unit -III 

6. From Contents of Unit -III 

7. From Contents of Unit -IV 

8. From Contents of Unit -IV 

9. From Contents of Unit -V 

10. From Contents of Unit -V 

Section-B 
Answer FIVE questions.        5X10=50 

A) From Contents of Unit-I 
OR 
B) From Contents of Unit-I 
A) From Contents of Unit-II 
 OR 
B) From Contents of Unit -II 
A) From Contents of Unit -III 
OR 
B) From Contents of Unit -III 
A) From Contents of Unit -IV 
OR 
B) From Contents of Unit -IV 
A) From Contents of Unit -V 
OR 
B) From Contents of Unit –V 
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                                     Applications of AI Applicable to Commerce and Management 
MODEL QUESTION PAPER (W.E.F2025-2026) 

Time:2½Hrs. MaxMarks:50 

Q. No Question Marks BL CO PO PI 

SECTION – A 

Answer any Five of the Following 5 X 4 = 20M  

1  Explain about any online platform to build AI application. 4M 2 1   

2 State about the Edge AI in smart Appliances. 4M 1 1   

3 Write a short note on “Structure of Data”. 4M 1 2   

4 Explain about Modalities of Data. 4M 2 2   

5 Define the process of Data Annotation and Labelling. 4M 2 3   

6 Discuss about various data collection methods for AI. 4M 2 3   

7 Write short note on Sentiment Analysis and Review Mining. 4M 1 4   

8 Discuss about the role of AI in Inventory Optimization and 
Demand Forecasting. 

4M 2 4   

9 Explain the role of AI in HR Applications? 4M 2 5   

10 Illustrate the “Explainable AI in E-Commerce”. 4M 2 5   

SECTION – B 

Answer Any five Questions  5 X 10 = 50 M   

1 Explain the hardware components for building AI applications? 
(OR) 
Explain briefly about AI in applications in daily life appliances? 

10M 
 
10M  

2 
 
2 

1 
 
1 

  

2 Explain the importance of data in building AI applications? 
(OR) 
Discuss about data repositories and data licensing in AI? 

10M 
 
10M  

2 
 
2 

2 
 
2 

  

3 Summarize about Stages and Components AI Data Pipeline? 
(OR) 
b) Distinguish between Data Cleaning/Preprocessing    and Data 
Splitting? 

10M 
 
10M  

2 
 
2 

3 
 
3 

  

4 Describe the Ethical Issues in AI Commerce in detail? 
(OR) 
Classify the Chatbots and Virtual Assistants in AI? 

10M 
 
10M  

3 
 
2 

4 
 
4 

  

 5 Explain the various applications of AI Business Intelligence? 
(OR) 
Explain about AI in Marketing? 

10M 
   10M  

2 
 
2 

5 
 
5 
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MODEL QUESTION PAPER (W.E.F 2025-2026) 

APPLICABLE TO COMMERCE AND MANAGEMENT 
Course Code Title of the Course L T P C 

25BCG202L 
25BCC202L 
25BBA202L 

     25BFS202L 

 

Applications of AI 

   
2 

 
1 

Prerequisites Basic Knowledge in AI 

 

   Practice Session 

Lab Practicals (No Coding) 

Lab 1 - Exploring Public Datasets (Orange Data Mining)  

● Visit a public repository (Kaggle, UCI, data.gov.in)  

● Download a dataset (e.g., rainfall data, literacy rates, or traffic accident statistics)  

● Procedure: 1. Open Orange → Add File widget → Load a CSV (e.g., Titanic dataset). 2. Connect to 

Data Table → View rows/columns. 3. Connect to Data Info → Check attributes, data types. 4. View in 

Data Table and Distributions widget.  

● Observation: Note numeric, categorical, missing values.  

● Outcome: Students understand structured data format in CSV.  

Lab 2 - Understanding Dataset Metadata and Formats  

● Take two datasets in different formats (CSV, JSON)  

● View metadata (description, features, size, license)  

● Compare domain-specific datasets (e.g., medical vs. finance)  

Lab 3 - Data Annotation Exercise  

● Use MakeSense.ai or VGG Image Annotator (VIA)  

● Annotate 10 sample images (traffic signs, fruits, or medical scans)  

● Export annotations in XML or YOLO format  

● Discuss annotation errors and challenges  

Lab 4 - Data Cleaning and Visualization (Orange Data Mining)  
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● Aim: To clean dirty data and visualize categorical and numeric attributes.  

● Procedure: 1. Load dataset. 2. Connect File → Edit Domain (to change types) and Impute (to fill 

missing values). 3. Compare cleaned vs. original in Data Table. 4. Distributions widget. 5. Check 

various features distribution. (Optional: Create simple bar charts/line charts to visualize trends using 

Google Looker Studio) ● Observation: Missing values filled with mean/median., Graphical 

representation of data.  

● Outcome: Learn importance of data cleaning., Students learn importance of visualization in 

preprocessing.  

Lab 5: Train/Test Split in Orange  

● Aim: To split a dataset for AI training/testing.  

● Procedure: 1. Load Titanic dataset. 2. Connect File → Data Sampler (70% train, 30% test). 3. 

Connect outputs to Data Table widgets to view.  

● Observation: Students see two different subsets.  

● Outcome: Concept of model validation using split data.  

Lab 6: Introduction to AI in Commerce – Use Case Exploration  

Prerequisite: Discuss conceptually about Clustering  

Objective: Understand how AI is applied in commerce through data visualization and clustering. 

Orange Workflow: Use Orange Data Mining Tool  

Widgets Used: File → Data Table → Scatter Plot → Hierarchical Clustering Dataset: Retail customer 

data (e.g., purchase frequency, amount spent)  

Dataset Link: Retail Sales Data  

Activities: · · · Load customer data and visualize spending patterns. Apply clustering to identify 

customer segments. Discuss how businesses can tailor services to each segment.  

Outcome: Students grasp how AI helps businesses understand and target consumers more 

effectively.  

Lab 7: Recommendation Engine Simulation  

Prerequisite: Discuss conceptually about Clustering  

Objective: Simulate collaborative filtering using similarity-based clustering.  

Orange Workflow:  

Widgets Used: File → Distance → Hierarchical Clustering → Data Table  

Dataset: User-product ratings matrix  

Dataset Link: Amazon Product Recommendation System  

Activities:  

● Calculate similarity between users.  
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● Group similar users and recommend products based on cluster behavior.  

● Discuss differences between collaborative and content-based filtering.  

Outcome: Students understand the logic behind recommendation systems and how they  

personalize user experience.  

Lab 8: Chatbot Intent Classification  

Prerequisite: Discuss conceptually about Linear Regression & Logistic Regression  

Objective: Train a model to classify customer queries into intents.  

Orange Workflow:  

Widgets Used: File → Preprocess Text → Bag of Words → Logistic Regression → Test & 

Score  

Dataset: Sample customer queries labeled with intents (e.g., “track order”, “return item”)  

Dataset Link: Customer Intent Classification  

Activities:  

● Preprocess and vectorize text data.  

● Train a classifier to predict query intent.  

● Evaluate accuracy and discuss chatbot training.  

Outcome: Students learn how AI understands and responds to customer queries.  

Lab 9: Sentiment Analysis of Reviews  

Prerequisite: Discuss conceptually about Naive Bayes  

Objective: Classify customer reviews as positive or negative.  

Orange Workflow:  

Widgets Used: File → Preprocess Text → Bag of Words → Naive Bayes → Test & Score  

Dataset: Product reviews with sentiment labels  

Dataset Link: Amazon Product Reviews – Sentiment Analysis  

Activities:  

● Clean and tokenize review text.  

● Train a sentiment classifier.  

● Visualize word clouds for positive vs. negative reviews.  

Outcome: Students analyze customer feedback and extract actionable insights.  

Lab 10: Demand Forecasting with Regression  

Prerequisite: Discuss conceptually about Linear Regression & Logistic Regression  

Objective: Predict future sales using regression models.  

Orange Workflow:  

Widgets Used: File → Linear Regression → Scatter Plot → Test & Score    
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Dataset: Historical sales data (e.g., monthly sales, promotions)  

Dataset Link: Comprehensive Retail Sales Data  

Activities:  

● Train a regression model to forecast sales.  

● Visualize predictions vs. actuals.  

● Discuss implications for inventory planning.  

Outcome: Students understand how AI supports demand forecasting and inventory control.  

Lab 11: Bias Detection in AI Models  

Prerequisite: Discuss conceptually about Linear Regression, Logistic Regression & Confusion  

Matrix  

Objective: Explore bias in predictive models and its impact.  

Orange Workflow:  

Widgets Used: File → Logistic Regression → Confusion Matrix → Distributions   

Dataset: HR hiring data with gender or age attributes  

Dataset Link: HR Data Analytics  

Activities:  

● Train a model to predict hiring decisions.  

● Analyze performance across demographic groups.  

● Discuss fairness, transparency, and ethical implications.  

Outcome: Students critically assess bias and propose ethical safeguards.  

Lab 12: Predictive Analytics for Business Intelligence  

Prerequisite: Discuss conceptually about Random Forest  

Objective: Use classification to predict customer churn.  

Orange Workflow:  

Widgets Used: File → Random Forest → Test & Score → ROC Analysis  

Dataset: Telecom or subscription data with churn labels  

Dataset Link: Telco Customer Churn – IBM Dataset  

Activities:  

● Train and evaluate a churn prediction model.  

● Interpret ROC curves and accuracy.  

● Discuss how businesses can act on predictions.  

Outcome: Students apply predictive analytics to improve customer retention.  

 

Lab 13: AI in HR and Marketing – Resume Screening & Segmentation  
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Prerequisite: Discuss conceptually about Clustering  

Objective: Classify resumes and segment customers using clustering.  

Orange Workflow:  

HR Task: File → Preprocess Text → Bag of Words → Logistic Regression  

Marketing Task: File → k-Means Clustering → Scatter Plot   

Resume Screening Dataset: Employee Hiring Data  

Customer Segmentation Dataset: Customer Segmentation Dataset  

Activities:  

● Screen resumes based on job fit.  

● Segment customers by behavior or demographics.  

● Discuss automation benefits and risks.  

Outcome: Students explore how AI enhances HR and marketing efficiency.  

Note: The Tools suggested above are tentative. Teacher/Student is free to choose any other  

similar tool to execute the said lab experiments. 
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I B.B.A HONOURS  

EXTERNAL EXAMINERS IN MANAGEMENT 
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S. No. Name of the Examiner with 
Designation 

Qualification Address 

1 Dr.P.Venu Gopal 

 Lect. in Commerce 
M.Com.,Ph.D Puttur  

Contact :9393887222 

2. N A Althaf 
Lect. In Commerce 

M.Com., Ph.D SKP GDC (A), Guntakal 
Cell No. 9533504662 

2 Dr. G. Ranganath 
Asst. Professorof commerce 

 

M.Com.,Ph.D GDC Arts College (A) 
Anantapur.  

Contact No:9885738060 

3 Dr. U. Prabhakar Reddy 

 Asst. Professor of commerce 

M.Com.,Ph.D GDC Arts College (A) 

Anantapur. 
Contact No:9966574101 

4 V.Bucchaiah  

Lecturer in commerce 

 

M.Com.,Ph.D GDC ,Kurnool  

Contact no:9441509276 

5 G.Gangaiah  

Lecturer in Commerce  

 

M.Com.,Ph.D GDC,Puttur.  

Contact no:9290293399 
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S. No. 
Name of the Examiner with 

Designation Qualification 

Address 

1 
C.Panduranga Rao  

Asst. Professor in Commerce  

 

M.Com.,Ph.D GDC, Kakinada 

Contact No: 9441069978 

2 
K Raja Sekhar  

 Lecturer in commerce 

  

M.Com.,M.Phil.

UGC NET 

 

SKP Government Degree College 

(A), Guntakal 

Ananthapuram Dt., 

 Contact: 9949173673 

3 
Dr.G.Thirumalaiah  

Asst. Professor of commerce 

M.Com.,Ph.D GDC Puttur 

Contact no: 9985313431 

4 
Dr.M.Venkataramaiah  

Asst.Professor of Commerce  

M.Com.,Ph.D SG GDC 

Piller.  

Contact no:7702673676 

5 
N.Tharani Krishna 

Lecturer in commerce  

M.Com.,Ph.D PVKN GC(A) Chittoor  

Mobile:7989680038 
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DEPARTMENT OF MANAGEMENT 

BBA HONOURS 

                                    EVALUATION / ASSESSMENT PATTERN 

EVALUATION SCHEME 

Standard  Operating Procedure for Continuous Internal Assessment (Internal Marks – 30). 

The Internal marks in all the courses/subjects will be awarded based on continuous 

internal assessment made during the semester concerned. For each Courses/subject 30 

marks are allotted for internal assessment and 70 marks are allotted for the End Semester 

Examination. 

Continuous Internal Evaluation (CIA): 

It has been decided to introduce Continuous Internal assessment marks for a total of 60 

marks, which are to be distributed as follows: 

*The total 60 Marks is scaled down to 30 Marks* 

 

Component I: CIE - I & CIE - II(20+20 =40 Marks) 

Two Internal Examinations, shall be conducted for assessment. These examinations will be 

S.No. Component Distribution of Marks 

1 CIE I(off line Exam after completion of 50% of syllabus) 20 

2 CIE II(off line Exam) 20 

3 Attendance 5 

Pedagogical Strategies  

4 Assignment 5 

5 Participation or Paper Presentation by Student 
Seminars/Workshops/Group Discussions/Quiz/Student Study 
Project/Field Visit/Survey 

5 

6 Swatch Bharat (Clean & Green) 5 

TOTAL 60 
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conducted during August/September (CIE –I) and January/February (CIE-II). CIE-I carries 

20 marks and CIE-II carries 20 marks. CIE- I will be conducted after completion of 50% of 

syllabus. The second internal examination, i.e., CIE– II, which will cover the remaining 

second half of the syllabus. The sum of both the CIEs will be considered for awarding marks 

for CIA. 

 

Suggestive Question Paper Pattern for CIE I &CIE II (Basedon BloomsTaxonomy)  : 

Though the faculty concerned is empowered to adopt their own pattern for question paper, a 

general and suggestive model for question paper is given below based on Blooms Taxonomy. 

 

QNo Learning Objective Marks 

1 Memorybased(Remember) 3 

2 Understand(Comprehension) 4 

3 Application 4 

4 Analysis 3 

5 Evaluation 3 

6 Creativity 3 

 TOTAL 20 marks 

 

The active verbs used to frame the question based on Blooms Taxonomy is given below 

for the convenience. 

\
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Important Note: 

Students who absent themselves from any CIE will lose the marks for the respective test. 

However, if a student is not able to write the CIE I /II because of his/her participation in an 

important event related to NSS/NCC or Games/ Sports representing the College/ University/ 

health grounds, the student has to get the prior permission of the Principal through the proper 

channel and submit the same to the Office of the Controller of Examinations. Deadline is 7 

days after the CIE. Applications submitted after the deadline will not be considered for the 

retest. 

 Component III: Attendance (5 Marks) 

Attendance mark will be awarded to the students based on their attendance percentage on a 

particular course. Faculty of each course has to award the attendance mark based on their 

subject attendance. 

The marks split-up is given below 
 

 

 

 

 

 

Attendance 

 

Above 95% 5 

91% to 95% 4 

86% to 90% 3 

81% to 85% 2 

75% to 80% 1 

Below 75% 0 
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Component IV: Assignment (5 Marks) 

One Assignment for each course must be submitted by a student in each semester. The 

marks allotted to this component will be awarded based on the performance of the student. 

The assignment topic may be assigned either individually or group. Assignment should be 

submitted by the student in the first half of the semester. Also maximum of 7 days should 

be given to students to submit the assignment. Assignments should be evaluated by the 

faculty concerned and the same to be verified by the student. The assignment should be 

kept in department for the Academic Audit by IQAC and also for external academic audit 

conducted by office of Commissionerate of Collegiate Education. The marks should be 

awarded by the faculty. 

 

Component V (Pedagogical Strategies): 

Participation /Paper Presentation in Student Seminars/Workshops/Group Discussions/ Quiz/ 

Student Study Project/Field Visit/Survey (5 Marks) 

In case of Classroom seminar, one seminar for each course must be presented by a student 

in each semester. Each student should be given individual topic for seminar; the student 

has to submit the seminar topic as assignment and the same will be presented minimum of 

10 minutes in the class through ICT. The seminar presented by the student should be 

evaluated by the subject faculty and based on the performance of the presentation,the 

marks will be awarded. Similarly, reports on field visits, educational tours, study projects 

in prescribed format will be considered for awarding marks in this component. 

 

In case of Quiz, offline/online quiz, it should be conducted after the CIE II and well before 

the SEE. Faculty concerned has to announce the schedule for the quiz and conduct the quiz.  

 

Semester End Examinations(SEE) 

The question paper is of 2 ½ duration for 70 marks. The suggestive question paper model 

is given that may be used for framing the question. This kind of question paper will be 

helpful in CO-PO Mapping and thereby graduate attributes. 

  

 

  Signature of the Chairman         Signature of the BOS Members  
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Academic Schedule: 2025-26 
UG Programmes ( Semester – I ) 

 

 

1. 
Commencement of regular class 

work for UG - Semester - I 
22-09-2025  

2. Dasara Vacation 28-09-2025 to 05-10-2025  

3. Mid - Term I Examinations 24-11-2025 to 29-11-2025  

4. Mid - Term II Examinations 02-01-2026 to 07-01-2026 

5. Pongal vacations 10-01-26 to 18-01-2026 

6. Closure Of Instructions 22-01-2026 

7. Practical Examinations 23-01-2026 to 24-01-26 

8. Semester end Examination 27-01-2026 to 03-02-2026 

 

Month wise working days for Semester - I 

Month September 
22-09-2025 

October 
2025 

November 
2025 

 

December 
2025 

January 
22-01- 2026 

Total 

Total Days 06 31 30 31 29 127 

Number of 

Holiday 

- 11 06 06 14 37 

Number of 

Working Days 

06 20 24 25 15 90 

 

Academic coordinator                 Controller of Examination                          Principal 
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Academic Schedule: 2025-26 
UG Programmes (II Semester) 

1. 
Commencement of Regular class work 

for UG - Semester - II 
05-02-2026  

2. Mid - Term I Examinations 09- 03-2026  to 13-03-2026 

3.  Summer Vacation 01-05-2026 to 31-05 -2026 

4 Re opening 01-06-2026 

5. Mid - Term II Examinations 15-06-2026 to 22- 06 -2026 

6. Closure Of Instructions 03-07-2026 

7. Semester end Examination     06 - 07-2026 to  14 -07-2026 

8. Practical Examinations 15-07-2026 to 16-07-2026 

9. 
Commencement of III Semester Class 

work 
17-07-2026 

 

Month wise working days for Semester - II 

Month February 
05-02-2025 

March 
2025 

April 
2025 

 

May 
2025 

June 
01-06- 2026 

Total 

Total Days 24 31 30 31 30 146 

Number of 

Holiday 

05 08 06 31 06 56 

Number of 

Working Days 

19 22 24 0 24 90 

 

 

Academic Coordinator                    Controller of Examination                          Principal 
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